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Bài 13: LÀM QUEN VỚI SOẠN THẢO VĂN BẢN 

1. Văn bản và phần mềm soạn thảo văn bản  

- Microsoft Word là phần mềm soạn thảo văn bản rất thông dụng do hãng Microsoft phát hành chạy trong 

môi trường hệ điều hành Windows. 

- Microsoft Word có rất nhiều phiên bản như :  

Microsoft Word 95, Microsoft    Word 2000, 

Microsoft  Word 2003, Microsoft  Word 2007, Microsoft  Word 2010 

2. Khởi động word: 

Cách 1: Nhấp đúp chuột vào biểu tượng  trên màn hình. 

Cách2: Nhấp chuột vào  trên màn hình Windows 

+Chọn  (hoặc Program) 

+ Chọn  

+ Chọn  

3. Có gì trên cửa sổ của Word? 

a)Thanh bảng chọn (Thanh Menu): Gồm nhiều bảng chọn cho phép chúng ta lựa chọn các chức năng 

làm việc. 

b) Các thanh công cụ: Chứa các nút lệnh cho phép làm việc trực tiếp từ các công cụ này. 

- Khu vực soạn thảo : cho phép soạn thảo nội dung văn bản. 

Ngoài ra còn có con trỏ văn bản, thanh cuộn ngang, cuộn dọc, thanh trạng thái 

4. Mở và lưu văn bản: 

* Mở văn bản: 
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- Chọn vào  File 

- Chọn Open (     ) 

- Xuất hiện hộp  thoại open. 

- Chọn tên tệp tin văn bản  chọn open 

* Lưu văn bản: 

- Chọn FileSave. 

(Chọn nút  Trên thanh công cụ) 

- Xuất hiện hộp thoại save as: 

+ Look in: Chọn ổ đĩa (đường dẫn) 

+ File name: Đặt tên cho văn bản 

+ Chọn save. 

* Kết thúc: 

- Chọn vào File->Close  

 - Nháy chọn nút X trên góc phải của màn hình. 
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Bài 14: SOẠN THẢO VĂN BẢN ĐƠN GIẢN 

1. Các thành phần của văn bản  

- Kí tự: là con chữ, số, kí hiệu. 

- Dòng: Tập hợp các kí tự nằm trên cùng một đường ngang từ lề trái sang lề phải. 

- Đoạn: Nhiều câu liên tiếp, có liên quan với nhau và hoàn chỉnh về ngữ nghĩa nào đó tạo thành một đoạn 

văn bản. Nhấn phím Enter để kết thúc một đoạn văn bản.  

- Trang: Phần văn bản trên một trang in được gọi là trang văn bản. 

2. Con trỏ soạn thảo 

- Con trỏ soạn thảo: là một vạch đứng nhấp nháy trên màn hình. Nó cho biết vị trí xuất hiện của kí tự 

được gõ vào. 

3. Quy tắc gõ văn bản trong  Word ? 

+ Các dấu câu như: ?,!,; … phải được đặt sát vào từ đứng trước nó. 

+ Các dấu ngoặc phải được đặt sát vào bên phải ký tự cuối cùng của từ ngay trước đó. 

+ Giữa các từ chỉ dùng một ký tự trống để phân cách. 

+ Ấn phím Enter để kết thúc đoạn văn bản chuyển sang đoạn văn bản mới. 

Ví dụ:  

Nước Việt Nam ( thủ đô là Hà Nội). 

 Nước Việt Nam (thủ đô là Hà Nội). 

4. Gõ văn bản chữ Việt 

- Để gõ được chữ Việt bằng bàn phím ta phải dùng chương trình hỗ trợ. (VietKey hoặc Unikey) 
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Bài 15 : CHỈNH SỬA VĂN BẢN 

1. Xóa và chèn thêm văn bản: 

* Xóa văn bản 

  - Backspace: xóa ký tự trước con trỏ soạn thảo. 

- Delete: xóa ký tự sau con trỏ soạn thảo. 

* Chú ý: Kiểm tra kỹ nội dung trước khi xoá. 

* Chèn thêm văn bản 

- Di chuyển con trỏ soạn soạn vào vị trí cần chèn và gõ thêm nội dung vào 

2. Chọn phần văn bản: 

- Đưa con trỏ chuột vào vị trí đầu rồi thực hiện kéo chuột đến cuối đoạn văn bản cần chọn và thả chuột. 

- Lưu ý: Nếu quá trình thực hiện bị sai hoặc không như ý muốn ta có thể khôi phục lại trạng thái ban đầu 

bằng cách nháy lệnh Undo    trên thanh công cụ. 

3.  Sao chép 

- Chọn đoạn văn bản cần sao chép: 

- Nháy chuột vào nút lệnh sao chép  Copy 

- Đưa con trỏ soạn thảo tới vị trí cần sao chép. 

- Nháy chuột vào nút lệnh dán  Paste 

4. Di chuyển 

- Chọn đoạn văn bản cần di chuyển: 

- Nháy chuột vào nút lệnh sao chép  Cut 

- Đưa con trỏ soạn thảo tới vị trí cần di chuyển đến. 

- Nháy chuột vào nút lệnh dán  Paste 
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Bài 16: ĐỊNH DẠNG VĂN BẢN 

1. Định dạng văn bản 

Định dạng văn bản là thay đổi kiểu dáng, vị trí của các kí tự (con chữ, số, kí hiệu), các đoạn văn bản và 

các đối tượng khác trên trang.  

*  Định dạng văn bản gồm 2 loại:  

- Định dạng kí tự. 

- Định dạng đoạn văn bản. 

2. Định dạng kí tự. 

- Định dạng kí tự là thay đổi dáng vẻ của một hay một nhóm kí tự. 

- Các tính chất phổ biến bao gồm: 

- Phông chữ:Thủ đô,THỦ ĐÔ , Thủ đô 

- Cỡ chữ:  Thủ đô, Thủ đô   Thủ đô 

- Kiểu chữ: Thủ đô ,Thủ đô   Thủ đô,Thủ đô   Thủ đô 

-Màu sắc: Thủ đô, Thủ đô 

2. Định dạng kí tự (tt) 

* Chọn phần văn bản  

a) Sử dụng các nút lệnh: 

- Thay đổi phông chữ: nháy chuột tại hộp Font  (tam giác hướng xuống). 

- Thay đổi kích cỡ chữ: nháy chuột tại hộp Size   (tam giác hướng xuống) 

- Tạo chữ đậm: nháy chuột vào nút lệnh Bold   

- Tạo chữ nghiêng: nháy vào nút lệnh Italic   

- Tạo chữ có gạch chân: nháy chuột vào nút lệnh Underline   

- Màu chữ: Nháy chuột vào nút lệnh Font Color  và chọn màu thích hợp. 
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b) Sử dụng hộp thoại Font: 

 FormatFont.. để mở hộp thoại Font. 

- Font: Hiển thị các phông chữ có sẵn trong máy. Chọn phông chữ. 

- Font Style: Chọn kiểu chữ. 

+ Regular: chữ thường. 

+ Italic: chữ nghiêng. 

+ Bold:  chữ đậm. 

+ Bold Italic: vừa nghiêng vừa đậm 

- Size: kích thước to, nhỏ của chữ. 

- Font color: Chọn màu sắc. 
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Bài 17: ĐỊNH DẠNG ĐOẠN VĂN BẢN 

1. Định dạng văn bản 

Khái niệm: Là thay đổi các tính chất của đoạn văn bản. 

 Các tính chất: 

- Kiểu căn lề. 

- Vị trí lề của cả đoạn văn bản so với toàn trang. 

- Khoảng cách lề của dòng đầu tiên. 

- Khoảng cách đến đoạn văn trên hoặc dưới. 

- Khoảng cách giữa các dòng trong đoạn văn 

. 2. Sử dụng nút lệnh định dạng đoạn văn bản. 

- Đặt con trỏ soạn thảo vào đoạn văn cần định dạng. 

- Căn lề: Nháy các nút sau: 

+  : Căn lề trái.     + : Căn giữa. 

+ : Căn lề phải.     + :  Căn thẳng hai lề. 

- Thay đổi lề cả đoạn văn:  

+ : Giảm mức thụt lề trái của cả đoạn. 

+  :Taờng mức thụt lề trái của cả đoạn. 

+ : Khoảng cách giữa các đoạn 

3. Sử dụng hộp thoại Paragraph định dạng 

- Đặt con trỏ soạn thảo vào đoạn văn cần định dạng. 

- Nháy vào bảng chọn FormatParagraph... 

* Mục Spacing: 

- Ô Before: Chọn khoảng cách so với đoạn văn trước. 
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- Ô After: Chọn khoảng cách so với đoạn văn sau. 

- Ô Line spacing: Chọn khoảng cách giữa các dòng trong một đoạn. 
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Bài 18: TRÌNH BÀY  VĂN BẢN VÀ IN 

1. Trình bày trang văn bản 

- Trình bày trang văn bản là xác định các tham số liên quan đến trang văn bản: Kích thước trang , đặt lề 

trang, chọn hướng trang… 

- Các yêu cầu cơ bản khi trình bày trang văn bản: 

* Chọn hướng trang  

* Đặt lề trang 

2. Chọn hướng trang và đặt lề trang 

- Vào File/Page Setup 

* Vào thẻ Margins 

- Orientation: Định hướng trang 

+ Đứng:   

+ Ngang:  

- Căn lề trái, phải, trên, dưới tại Margins (Left, Right, Top, Bottom). 

* Vào thẻ Paper 

- Định khổ giấy in Paper size(A4, A5…) 

- Nháy OK kết thúc 

* Chú ý: Văn bản có nhiều trang , việc tình bày trang có tác dụng đến mọi trang văn bản. 

3. In văn bản 

* Xem trước khi in: 

  Cách 1: Kích vào biểu tượng     

trên thanh công cụ. 

  Cách 2: Vào File\ Print Preview. 
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* In văn bản 

- Nháy nút Print  in toàn bộ văn bản. 

- In có lựa chọn: 

Vào File Print 

 Hộp thoại Print xuất hiện: 

   + All : In tất cả  

   + Current page : In trang hiện tại  

   + Pages : In trang qui định. 

   + Number of copies: Số bản sẽ in  

- Nháy OK để in 
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Bài 19: TÌM KIẾM VÀ THAY THẾ 

1.Tìm phần văn bản 

Dùng bảng chọn: 

Edit\Find (Tìm kiếm) xuất hiện hộp thoại Find and Replace (tìm kiếm và thay thế). 

Find what: Gõ nội dung cần tìm.  

Find Next: Để tìm. 

Cancel: Thoát khỏi hộp thoại Find and Replace. 

2. Thay thế 

- Để thay thế thì: Vào bảng chọn Edit Replace Hộp thoại Find and Replace xuất hiện 

+ Find what: nhập nội dung cần thay thế. 

+ Replace with: Nhập nội dung thay thế. 

+ Nháy Find next để tìm. 

+ Nháy Replace để thay thế nội dung tìm được 

+ Nếu không muốn thay thế thì nháy Find next để tìm tiếp hoặc nháy Cancel dừng. 
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Bài 20: THÊM HÌNH ẢNH MINH HỌA 

1.Chèn hình ảnh vào văn bản: 

- Hình ảnh minh hoạ thường được dùng trong văn bản và làm cho nội dung của văn bản trực quan, sinh 

động hơn,dễ hiểu hơn, văn bản đẹp hơn 

- Hình ảnh thường được vẽ hay tạo ra từ trước bằng phần mềm đồ họa (paint) 

 hay ảnh được chụp, ảnh được tải từ Internet…  

- Hình ảnh được lưu dưới dạng các tệp hình ảnh (tệp đồ họa) 

- Để chèn hình ảnh vào văn bản, ta thực hiện các bước sau đây: 

- Đưa con trỏ soạn thảo vào vị trí cần chèn hình ảnh 

- Nháy dụng lệnh Picture trên dải lệnh Insert, xuất hiện hộp thoại: 

+ Chọn thư mục lưu hình ảnh 

+ Chọn tệp hình ảnh 

+ Nháy Insert 

2.Thay đổi bố trí hình ảnh trên văn bản: 

- Thông thường hình ảnh được chèn vào văn bản theo một trong hai cách: 

a)Trên dòng văn bản. 

b)Trên nền văn bản. 

- Để thay đổi cách bố trí hình ảnh, ta thực hiện các bước sau: 

1. Nháy chuột chọn hình ảnh. 

2. vào format -> picture (hoặc format -> autoshape,.. tuỳ theo đối tượng là hình ảnh hay hình vẽ), xuất 

hiện hộp thoại format picture (hoặc formatoutoshape) chọn trang layout 

3. Chọn Inline with text (nằm trên dòng văn bản) hoặc square (nằm trên nền văn bản) và nháy OK 
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Bài 21: TRÌNH BÀY CÔ ĐỌNG BẰNG BẢNG 

1. Tạo bảng: 

* Cấu tạo bảng 

- Bảng gồm có các hàng và các cột. Giao của hàng và cột gọi là ô. 

* Tạo bảng: 

- Đặt con trỏ tại vị trí cần chèn 

Cách1: Dùng biểu tượng trên thanh công cụ 

B1: Chọn nút  trên thanh công cụ.  

B2: Nhấn giữ phím trái chuột di chuyển để chọn số hàng và số cột rồi thả chuột.  

Cách 2: Dùng Menu lệnh 

- Đặt dấu nháy tại vị trí cần tạo bảng. 

B1: Chon Table Insert TableXuất hiện hộp thoại Insert Table 

B2: Number of columns: Chọn số cột. 

+ Number of rows: Chọn số dòng. 

B3: Chọn OK đồng ý và kết thúc. 

2. Thay đổi kích thước của cột và hàng 

- Đưa con trỏ chuột vào đường biên của cột (hay hàng) cần thay đổi đến khi con trỏ có dạng mũi tên. 

- Kéo thả chuột sang trái, phải (hoặc lên, xuống) để điều chỉnh độ rộng của cột (hay độ cao của hàng). 

3.Chèn thêm cột hoặc dòng 

- Đặt con trỏ tại vị trí cần chèn cột hay dòng. 

- Vào Table -> Insert. 

+ Columns to the left: Chèn cột bên trái. 

+ Columns to the right: Chèn cột bên phải. 

+ Rows Above: Chèn hàng phía trên. 
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+ Rows Below: Chèn hàng phía dưới. 

* Chú ý Để chèn thêm dòng vào cuối bảng một cách nhanh chóng thì ta thực hiện:Đặt con trỏ vào 

ô góc dưới bên phải và nhấn Tab trên bàn phím. 

4. Xoá hàng, cột hoặc bảng. 

* Để xoá hàng, cột hoặc bảng ta sử dụng lệnh sau: 

- Chọn khối văn bản cần xoá. 

- Vào Table -> Delete. 

+ Table: Xoá bảng. 

+ Columns: Xoá cột. 

+ Rows: xoá hàng. 
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Đề ôn tập học kì 2 môn Tin học lớp 6 

I/ PHẦN TRẮC NGHIỆM  

Chọn câu trả lời đúng nhất rồi điền và ô bên dưới: 

Câu 1. Để khởi động Word em nháy đúp vào biểu tượng nào: 

A.                     B.                  C.                D.  

Câu 2. Các thành phần của văn bản là: 

A. Dòng, đoạn, trang B. Dòng, đoạn 

C. Kí tự, từ, dòng, đoạn, trang D. Kí tự, trang 

Câu 3.  Biểu tượng nào là nút lệnh copy 

A.                        B.                     C.              D.  

Câu 4. Nút lệnh nào là căn lề trái 

A.                       B.                     C.              D.  

Câu 5. Nháy lần lượt các nút nào để được chữ in đậm và gạch chân : 

A.             B.               C.               D.   

Câu 6.Có bao nhiêu cách cơ bản để định dạng đoạn văn bản? 

A. 1 cách                  B. 2 cách               C. 3 cách             D. 4 cách 

Câu 7. Khi mở văn bản có sẵn, nhanh chóng lưu nội dung mới gõ vào ta Nháy nút: 

A.                        B.                       C.               D.  

Câu 8 Để có thể gõ được tiếng việt khi soạn thảo văn bản, máy tính cần có thêm phần mềm nào sau: 

A.Mario B.Unikey                       C. Bàn phím                D.Chuột 

Câu 9: Các tập tin soạn thảo văn bản trong Word có đuôi là: 

 A. DOCX B. XLS C. TXT D. BMP 

Câu 10: Chọn câu gõ sai quy tắc trong các câu sau đây? 

 A. Ôi , trăng sáng quá!             B. Nước Việt Nam (thủ đô là Hà Nội). 

 C. Trời nắng, ánh mặt trời rực rỡ.            D. Trường em xanh, sạch đẹp. 

Câu 11: Chức năng chính của Microsoft Word là gì? 

 A. Tính toán và lập bảng biểu.           B. Soạn thảo văn bản. 

 C. Tạo các tệp tin đồ hoạ.            D. Tạo các tập tin thực thi. 

Câu 12: Thông thường khi soạn thảo văn bản thì văn bản bắt đầu từ vị trí: 

A. Căn giữa B. Con trỏ chuột  C. Lề bên trái      D. Lề bên phải. 

Câu 13: Biểu tượng của Microsoft Word 2010 là ? 

A/   B/   C/   D/  

Câu 14: Lệnh nào thực hiện thao tác lưu văn bản? 

https://vndoc.com/tai-lieu-hoc-tap-lop-6
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A/   B/   C/   D/  

Câu 15: Lệnh nào thực hiện thao tác in văn bản? 

A/   B/   C/   D/  

Câu 16: Tập hợp các kí tự nằm trên cùng một đường ngang từ lề trái sang lề phải của trang là? 

A/ Dòng  B/ Hàng  C/ Cột   D/ Trang văn bản 

Câu 17: Phím Delete có tác dụng? 

A/ Xóa kí tự trước con trỏ soạn thảo  B/ Xóa kí tự sau con trỏ soạn thảo 

C/ Xóa kí tự cả trước lẫn sau   D/ Cả A và B sai 

Câu 18: Lệnh  thực hiện thao tác căn thẳng hai lề là? 

A/    B/    C/    D/  

Câu 19: Trong MS word 2010, để chèn ảnh từ thư viện có sẵn chọn lệnh: 

A/ Tại thẻ Insert, chọn nút Picture   B/ Tại thẻ Insert, chọn nút Smartart 

C/ Tại thẻ Insert, chọn nút Clip art   D/ Tại thẻ Insert,chọn nút Screenshot 

Câu 20: Trong MS word 2010, chèn ảnh từ các nguồn sưu tầm ta chọn lệnh: 

A/ Tại thẻ Insert, chọn nút Picture   B/ Tại thẻ Insert, chọn nút Smartart 

C/ Tại thẻ Insert, chọn nút Clip art   D/ Tại thẻ Insert,chọn nút Screenshot 

Câu 21: Chương trình nào sau đây cho phép gõ tiếng việt trong MS word 2010? 

A/ Unikey  B/ Vietkey 2000  C/ Unicode  D/ Cả A và B đúng 

Câu 22:Để gộp các ô đang chọn của 1 bảng thành 1 ô? 

A/ Tại thẻ Layout nhấn Margin cells  B/ Tại thẻ Layout nhấn Split table 

C/ Tai thẻ Layout nhấn Merge cells   D/ Tại thẻ Layout nhấn Split cells  

Câu 23:Để chọn hướng trang nằm ngang, ta chọn thẻ Page Layout, chọn: 

A/ Portrait  B/ Landscape  C/ Setup  D/ Margins 

Câu 24:Để chuyển con trỏ soạn thảo về đầu văn bản, ta nhấn tổ hợp phím: 

A/ Ctrl+page up B/ Ctrl+end  C/ Home  D/ Ctrl+home 

 

II/ PHẦN TỰ LUẬN 

Câu 1 Định dạng văn bản là gì? Mục đích? Có mấy loại? 

Câu 2 Nêu những điểm giống nhau và khác nhau về chức năng của phím Delete và Backspace? 

Câu 3 Nêu các tính chất phổ biến của định dạng kí tự? Có mấy cách để định dạng kí tự? 

Câu 4 Nêu các thao tác để sao chép, di chuyển văn bản? 

Câu 5: Định dạng đoạn văn bản là gì? Nêu khái niệm về sao chép, di chuyển phần văn bản?   

Câu 6: Trình bày thao tác lưu văn bản đã có thành một văn bản với tên khác?           

Câu 7: Nêu các bước chèn hàng và cột? 

B. PHẦN THỰC HÀNH:   

Đề 1 
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Soạn thảo nội dung, chỉnh sửa, và định dạng trang văn bản theo mẫu, tô màu chữ theo ý thích, sau đó 

lưu lại trên ổ đĩa D với tên là: Tên em + Lớp (Ví dụ: NgocHa – lop6). 

 

LÒNG MẸ 

Những chiều khi nắng tắt bên sông 

Màu tím hoàng hôn ngập cánh đồng 

Tôi đón mẹ về nơi cuối xóm 

Chợ chiều tan mẹ về bước thong dong. 

 

DANH SÁCH HỌC SINH 

STT Họ và tên Năm sinh Lớp 

1 Hồ Thị Nhung 18/08/1998 6 

2    

    

B. PHẦN THỰC HÀNH:  

HS ñaùnh ñuùng vaên baûn khoâng sai loãi chính taû ñöôïc  

Định dạng nội dung văn bản đúng theo mẫu được  

Cheøn ñöôïc hình aûnh ñuùng theo maãu ñöôïc  

HS taïo ñöôïc baûng bieåu ñöôïc  

Vieát và trình bày nội dung đúng theo bảng ñöôïc  

Löu vaên baûn ñuùng với tên là: Tên em + Lớp (Ví dụ:  NgocHa - lop6)  
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ĐỀ 2: 
Câu 1: Em hãy gõ và định dạng đoạn văn bản theo mẫu dưới đây: 

BIỂN ĐẸP 

Một buổi chiều lạnh, nắng tắt sớm. Những đảo xa lam nhạt pha màu trắng sữa. Không có gió mà sóng vẫn 

vỗ đều, rì rầm. Nước biển dâng đầy, quanh đặc một màu bạc trắng, lấm tấm như bột phấn trên da quả nhót. 

 

Chiều nắng tàn, mát dịu. Biển trong veo màu mảnh trai. Đảo xa tím pha hồng. Những con sóng nhè nhẹ liếm 

trên bãi cát, bọt sẫm màu bưởi đào. 

Lại đến một buổi chiều gió mùa đông bắc vừa dừng. Biển lặng đỏ đục, đầy như mâm bánh đúc, loáng thoáng 

những con thuyền như những hạt lạc ai đem rắc lên.  

(Theo Vũ Tú Nam) 

   Yêu cầu: 

a) Tạo tiêu đề (Biển đẹp) có màu chữ (đỏ), kiểu chữ (đậm), căn lề (căn giữa). Cỡ chữ của tiêu đề lớn hơn so 

với cỡ chữ của phần nội dung.  

b) Các đoạn nội dung có màu chữ (xanh), có dòng đầu thụt lề và được căn thẳng hai lề. Đoạn cuối cùng (Theo 

Vũ Tú Nam) có màu chữ (đỏ), kiểu chữ (nghiêng) và được căn lề thẳng lề phải. 

c) Chèn hình ảnh vào vị trớ giống như trên hình mẫu và căn hình vào giữa (Đường dẫn lưu hình ảnh: 

D:\KIEM TRATHK2 LOP 6\bien dep)      

d) Sử dụng hộp thoại Page Setup để chọn hướng trang (trang đứng), lề trang (lề Trên: 2cm, lề dưới: 2cm, lề 

trỏi: 2cm, lề phải: 2cm)     

Câu 2: Em hãy tạo bảng theo mẫu dưới đây:    

STT Họ và tên Lớp Môn học Điểm thi 

1 Nguyễn Văn An 8A Toán học 8 

2 Trần Thị Bích 8B Tin học 9 

3 Nguyễn Văn Tính 8C Lý 8 
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4 Phan Văn Vinh 8D Văn 5 

5 Nguyễn Văn Bé 8E Sử 9 

 

 

 

 

 


